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This document summarizes the differences between Cisco Application Analysis Solution (Cisco AAS) 
Release 2.1 and Release 2.0.1. Release 2.1 is a full release that replaces existing 2.0 installations. If you 
are updating to Release 2.1, you should review this document.
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Installing Cisco Application Analysis Solution 2.1

For detailed instructions on how to install the Release 2.1 software, refer to the 
instructions in the Installation Guide for Cisco Application Analysis Solution. 
You can view an online version of this document at Cisco.com: 

http://www.cisco.com/en/US/products/ps6362/prod_installation_guides_list.html

WARNING—If you are using Release 1.1 software or earlier, you must update 
to Release 2.0 before you update to Release 2.1. For details on updating from 
Release 1.1, see the Installation Guide for Cisco Application Analysis Solution 
for Release 2.0 at the above URL.

http://www.cisco.com/en/US/products/ps6362/prod_installation_guides_list.html
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Release 2.1 Description

Release 2.1 provides enhancements to the existing capabilities of 
Cisco Application Analysis Solution. It also implements suggestions and fixes to 
software problems reported in earlier releases.

The following sections highlight the changes to 
Cisco Application Analysis Solution that were introduced in Release 2.1.
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Installation and License Enhancements

The following enhancements are available in 2.1:

• License File Format Change on page 3

• Installation Utility Change on page 3

• Migration of Preference Values on page 4

License File Format Change

The format of the license file has been changed to hold additional information 
about each license. This change has the following effects:

• The 2.1 license server automatically converts pre-2.1 license files to the new 
format when it reads them. A 2.1 license server can serve licenses to any 
release of Cisco Application Analysis Solution.

• After a pre-2.1 license file has been converted, pre-2.1 license servers 
cannot use it and should be replaced with 2.1 license servers.

If you need to run a mix of 2.1 and pre-2.1 applications, install a 2.1 license 
server (using the “Floating—serve licenses from this computer” option) and 
configure the applications to contact it.

Installation Utility Change

Cisco Application Analysis Solution is now installed using the InstallAnywhere 
installation technology, which provides a Java-based graphical installer.

Note—Because these installers use a different technology, they generally take 
longer and require slightly more disk space during installation than installers 
from previous releases. 

For more information, see the installation instructions.
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Migration of Preference Values

When upgrading, your preference values are migrated to ensure a smooth 
transition.

The migration process occurs when Cisco Application Analysis Solution is 
started for the first time. When the migration is complete, a dialog box informs 
you of the migration. Click the Show Details… button to view a detailed log of 
the migrated preferences. If the dialog box indicates, you may have to restart 
Cisco Application Analysis Solution for the migrated preferences to become 
effective.

Note the following:

• The migration of preference values occurs when all of the following 
conditions are true:

— No preference file exists. (This is always true when 
Cisco Application Analysis Solution is started for the first time after 
installation.)

— A previous release of Cisco Application Analysis Solution is already 
installed.

• If more than one previous release is already installed, the migration process 
uses the most recent release.

• To bypass the migration process, use the “-skip_preferences_migration” 
command-line option when starting Cisco Application Analysis Solution.
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Application Analysis Enhancements

The following enhancements are available in 2.1:

• Capture Agent Enhancements on page 5

• Opening Cisco AAS-Related Files Directly in Windows on page 6

• Web Report Enhancements on page 7

• User Think Time on page 7

• Modeling Web Services in Cisco AAS Whiteboard on page 8

• Modeling UDP-Based Applications in Cisco AAS Whiteboard on page 8

• Cisco AAS Decodes Module Enhancements on page 9

— Wireshark 0.99.5 Support on page 9

— DB2 Decodes and Transaction Analysis on page 10

— IPv6 Support on page 10

— File-Transfer Analysis for SMB/CIFS, FTP, and NFS on page 10

Capture Agent Enhancements

The 3.6 version of the Cisco AAS Capture Agent has the following 
enhancements: 

• Support on Windows hosts that have the following chip sets:

— 64-bit86-64

— x64

— Opteron

— AMD64

— Intel 64

— EM64T

Note—Itanium chip sets are not supported by the 3.6 capture agents.

• Support on Windows Vista hosts

• Windows capture agents now use WinPcap version 4.0.1.

The 3.6 capture agents are supported on all of the following Windows platforms:

• Windows 2000 (x86)

• Windows Server 2003 (x86)

• Windows XP (x86)
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• Windows Vista (x86)

• Windows Server 2003 (x64)

• Windows XP (x64)

• Windows Vista (x64)

Opening Cisco AAS-Related Files Directly in Windows

The software installer gives you the option to create file associations 
automatically for Cisco AAS-related files on Windows. If you select this option, 
you can then double-click on a Cisco Application Analysis Solution-related file 
in a Windows file browser and open the file directly.

The software installer can associate the following file types with 
Cisco Application Analysis Solution: 

• Cisco Application Analysis Solution (.atc.m)—Opens in main 
Cisco Application Analysis Solution window 

• Cisco AAS Whiteboard (.aed.m)—Opens in Cisco AAS Whiteboard 

• Cisco application capture (.appcapture) and other common capture formats 
(.enc, .cap, .prn, etc.)—Opens in Cisco AAS QuickView 

• Project (.prj)—Opens in Project Editor
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Web Report Enhancements

 Web Reports have been significantly enhanced for this release. Enhancements 
include:

• Expanded content—A web report can include all the elements that are 
available in an MS Word report: Executive Summary, statistic graphs, 
customized Tier Pair Circle graphics, and so on.

• Customization—You can now specify the name of a web report and the type 
of content to include.

• Updated “look and feel” of web reports

User Think Time

Cisco Application Analysis Solution can now consider the presence of human 
think time at a client tier, and separate this time from application processing 
time. In the context of Cisco Application Analysis Solution, user think time refers 
to the delay incurred whenever a client-side application waits for user input 
before it can proceed. For example, an application might need to wait for a user 
to click OK to confirm a request before it sends the request to a server. 
Previously, any captured think time was considered part of tier processing 
delay. 

You can configure how Cisco Application Analysis Solution detects user think 
time automatically. You can also specify whether the tier delay in a dependency 
is due to think time or application processing. 

This change provides two major benefits:

• Analyses of client-side applications are more accurate, because user think 
time is considered as a separate category of delay from tier processing. 

• It is easier to capture and analyze applications that consist of multiple 
user-level transactions that are separated by think time.
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Modeling Web Services in Cisco AAS Whiteboard

This release has the following new features for modeling web services:

• Import operation, message, and argument definitions directly from WSDL 
(Web Service Definition Language) files

• WSDL Operations Palette that uses a treeview to show all defined 
operations, messages, and arguments

• Ability to perform “drag-and-drop” operations from the WSDL Operations 
Palette

• Customize attributes such as operation processing time, SOAP/HTTP 
overhead, and message/argument size

Modeling UDP-Based Applications in Cisco AAS Whiteboard

You can now simulate UDP-based Cisco Application Analysis Solution and 
Cisco AAS Whiteboard files in QuickPredict and discrete event simulations.
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Cisco AAS Decodes Module Enhancements

The enhancements are

• Wireshark 0.99.5 Support on page 9

• DB2 Decodes and Transaction Analysis on page 10

• IPv6 Support on page 10

• File-Transfer Analysis for SMB/CIFS, FTP, and NFS on page 10

Wireshark 0.99.5 Support

Wireshark is now the supported external decoder for 
Cisco AAS Decodes Module. Ethereal is no longer supported. 

Note the following:

• As of this documentation release, Cisco AAS supports Wireshark 0.99.5.

• Cisco recommends that you install Wireshark on your local computer before 
you run the 2.1 release for the first time. This will ensure that Cisco AAS sets 
the External Decoder Program preference automatically for Wireshark.

If you install Wireshark after you run the 2.1 release, you must set the 
External Decoder Program preference manually. To do this:

— Choose Edit > Preferences.

— Set the ACE > Decodes > External Decoder Program preference to 
specify the full path and file name (for example, 
C:\Program Files\Wireshark\tshark.exe). 

For more information, see the 2.1 Installation Instructions. 

• You can use the Wireshark decoder with Cisco Application Analysis Solution 
files that were created with Ethereal. However, a Cisco Application Analysis 
Solution file retains decodes from the decoder that was installed when the file 
was created. To use Wireshark decodes, do one of the following:

— Recreate the Cisco Application Analysis Solution file (recommended)

— Redecode some or all of the traffic. 

You can redecode traffic in the Tree View and the Tier Pair Circle. Select 
the tier pair or transaction of interest, right-click, and choose Redecode 
As. (For more information about this operation, see the following section 
of the product documentation: Application Analysis > 
Protocol Decodes > Redecoding Traffic.)
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DB2 Decodes and Transaction Analysis

This release supports decodes of DB2 versions 8.1, 8.2, and 9.0. You can use 
the following features to analyze DB2 applications:

• Tree View tabbed page—When you set the “View by” pull-down menu to 
Application Transactions, the treeview organizes the Cisco Application 
Analysis Solution file into separate DB2 transactions. This is helpful for 
identifying problematic SQL statements.

• Protocol Decodes Viewer—This window shows details of SQL operations 
and DRDA commands. DB2 decodes appear under “DRDA” in the Protocol 
Decodes Viewer. 

For more information, see DB2 Decodes and Transaction Analysis.

IPv6 Support

You can now import capture files that contain IPv6 data. You can also view IPv6 
decode information in Cisco AAS QuickView and in the Protocol Decodes 
Viewer.

File-Transfer Analysis for SMB/CIFS, FTP, and NFS

This release supports enhanced decoding and transaction analysis for NFS 
versions 3 and 4, SMB (Server Message Block) (NTLM 0.12), and CIFS 
(Common Internet File System) version 1.0. The following features are available 
for analyzing these protocols:

• Enhanced decodes in the Protocol Decodes Viewer

• Grouping of application messages into transactions in the Tree View (select 
View by: Application Transactions)

• File Transfers tabbed page in Cisco AAS AppDoctor—This page shows 
summary information and statistics for the file transfers.You can also include 
this information in  web and RTF reports.

• Application Message Chart visualization—To color messages by transaction 
type, choose View > Visualization > File Transfer Operations.

Note—Due to known performance issues, the NFS analysis is turned off by 
default. To enable the NFS analysis, set the "Enable NFS Decoder" preference 
to true before you import capture data into Cisco Application Analysis Solution.
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Discrete Event Simulation Enhancements

The following discrete event simulation (DES) enhancements are available in 
2.1:

• Enhanced Support for Importing and Analyzing Cisco IOS XR Devices on 
page 11

• Module-Centric Reports on Global Packet Statistics on page 12

• HAIPE Model Enhancements on page 12

• Circuit-Switched Model No Longer Included in Model Library on page 12

• Global Packet Statistics on page 12

• Compilation Behavior on page 13

• Time-Precision Preference on page 14

• Compilation and Linking Preferences on page 14

Note—Cisco AAS-Advanced Capture Module is needed to use the discrete 
event simulation features in Cisco AAS.

Enhanced Support for Importing and Analyzing Cisco IOS XR Devices

Cisco AAS now supports version 3.4.1 of Cisco IOS XR. This change adds 
support for many of the new features that were added to Cisco IOS XR since 
version 3.2, which was the highest supported version of Cisco IOS XR in 
previous releases.

The Cisco IOS XR enhancements add support for the following:

• Routing protocols: BGP, ISIS, OSPF, RPL, and static routing

• MPLS: LDP, RSVP, traffic engineering, VPN

• Quality of service

• IP addressing and services: access lists, ARP, HSRP, network stack IPv4, 
prefix lists
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Module-Centric Reports on Global Packet Statistics

The global packet statistics feature now has module-centric views in addition to 
the original node-centric views. The module-centric approach is useful for 
performing packet throughput analysis of a simulation. With it, you can easily 
determine which module is dropping the most packets, then examine the nodes 
containing a given module to see which ones are major contributors to the 
problem.

HAIPE Model Enhancements

The HAIPE (High Assurance Internet Protocol Encryptor) model has been 
enhanced to support the following:

• Dynamic security associations using HAIPE IKE

• Orphan SA Recovery using HAIPE IKE

• Transport mode transforms

• SA based statistics (provides the ability to view statistics on a per-SA basis 
and at the node level

• Ability to configure a security association to be used by multiple security 
policies 

• Ability to configure a manual peer enclave prefix table entry using the peer 
HAIPE device's name rather than the CT (cipher text) IP address. As part of 
this enhancement, the HAIPE Parameters > Manual Peer Enclave Prefix 
Table (PEPT) > Peer CT Address attribute has been replaced by the HAIPE 
Parameters > Manual Peer Enclave Prefix Table (PEPT) > Peer HAIPE.

Circuit-Switched Model No Longer Included in Model Library

The circuit-switched model is no longer shipped as part of the model library. 
Although it is no longer maintained or supported, the model can be obtained 
from the Cisco Technical Assistance Center.

Global Packet Statistics

Global packet statistics represent an expansion of the Packet Info report 
formerly available in the simulation console and DES log. These statistics 
provide a “high-level” view of simulation behavior, letting you quickly get a sense 
of whether a simulation is performing as expected. You can use this information 
as a first step in debugging a model.

The global packet statistics feature introduces the following changes to the 
Packet Info report:

• The number of packets created, copied, and destroyed during the simulation 
are reported per packet format and per node.
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• The checkbox used to control collection of these statistics has moved from 
the Execution > Advanced > Kernel Reports page of the Configure/Run DES 
dialog box to the new Outputs > Global Packet Statistics page.

• Statistic collection is enabled by default (but continues to be available only 
for sequential development kernels).

• The collected statistics are saved in an output table file with a name of the 
form <project_name>-<scenario_name>-DES-<run_number>.ot.

• The collected statistics can be viewed in the Results Browser under a tab 
corresponding to the output file name; for example, 
“DES Run (<run_number>) Tables”.

Figure 2.1-1   Packet Statistics in Results Browser

Note—When the Packet Data Sharing Mode (sim_packet_sharing) preference 
is set to conservative or full, the content of “copied” packets is shared unless 
changes are needed. Regardless of this preference, the packet statistics count 
all packets that were copied or destroyed, as well as those that would have been 
copied or destroyed if the packet sharing optimization was disabled.

Compilation Behavior

When preparing for a discrete event simulation, 
Cisco Application Analysis Solution programs that compile files (such as 
op_mkso, op_mksim, and op_runsim) now systematically keep compiling files 
instead of stopping at the first error. You can kill the build process if needed; 
otherwise, all of the specified models are compiled to provide a general report 
of missing models, conflicting models, and so on.



Readme

14 Cisco Application Analysis Solution/ Release 2.1

Time-Precision Preference

The following DES-related preference has been added:

• log_time_precision—Specifies the number of decimal places recorded for 
simulation times in the DES log (the default is 12).

Compilation and Linking Preferences

New preferences let you define flags and libraries specific to 32-bit and 64-bit 
architectures. These preferences are:

• comp_flags_32bit

• bind_shobj_flags_32bit

• bind_shobj_flags_64bit

• bind_shobj_libs_32bit

• bind_shobj_libs_64bit

• bind_static_flags_32bit

• bind_static_flags_64bit

• bind_static_libs_32bit

• bind_static_libs_64bit
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General GUI Enhancements

The following enhancements are available in 2.1:

• Visualization Enhancement on page 15

• Treeview Enhancements on page 15

Visualization Enhancement

The GUI now supports anti-aliasing, which softens edges, thus providing a 
smoother and sharper look.

Treeview Enhancements

Treeviews have been enhanced with new functionality and an updated look. 
The treeview enhancements include the following features:

• Keyboard Shortcuts for Treeviews

Use the following shortcut keys to quickly navigate through a treeview.

• Type Ahead Searching—You can now easily locate items in a treeview by 
typing the first one or more characters of the name. Type ahead searching 
starts with the selected item. If you repeat the same characters, the search 
cycles through the treeview. Note that the type ahead searching feature 
considers displayed (non-hidden) items only.

• Treeview Appearance—The enhanced treeviews have an updated 
three-dimensional look. Additionally, there are new preferences to define the 
font and the lines between treeview nodes.

— treeview_font—Specifies the default font used for treeviews.

— treeview_connector_style—Specifies the line style used in a treeview to 
show connections between nodes. Select from Dotted Lines, Solid Lines, 
or No Lines.

Shortcut Key Description

+ (plus) Expands a treeview node.

- (minus) Collapses a treeview node.

<Right Arrow> Expands the treeview node and selects the first child node.

<Left Arrow> Collapses the treeview node and selects the parent node.

<Backspace> Selects the parent node
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Project Editor Enhancements

The following enhancements are available in 2.1:

• Adding Ports to Existing Devices on page 16

• Easier Statistic Selection in Results Browser on page 17

• Edit Attribute Dialog Box Enhancements on page 18

• Enhanced Usability of Compound Attribute Table Dialog Box on page 19

• Subnet Enhancements on page 19

• Logical Object Selection Enhancements on page 20

• Zooming/Panning Enhancements on page 20

• Map Improvements on page 21

• Embedded Bird’s-eye Viewer on page 22

• Toggle Display of Links on page 22

Adding Ports to Existing Devices

You can now add ports to an existing device so that it accommodates new links. 
This makes it much easier to upgrade nodes and to add or upgrade links 
manually. Two modes of operation are supported:

• Automatic upgrade—If you connect one or more links to a node manually, 
and that node does not have enough ports, 
Cisco Application Analysis Solution will add the necessary ports to support 
the new links. 

• Manual upgrade—To add ports to a device manually, right-click on it and 
choose Add Ports. A wizard prompts you for the number and type of ports to 
add.

This feature has the following constraints:

• You can add new ports to switches, routers, router/switches, firewalls, 
clouds, and hubs only. You cannot add ports to traffic source/destination 
nodes such as workstations, servers, and LANs.

• Cisco Application Analysis Solution upgrades nodes automatically only 
when you add or upgrade links manually in the Project Editor. This 
functionality is not invoked by operations that can make comprehensive 
changes to the network topology (for example, running a link-dimensioning 
design action).
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• Cisco Application Analysis Solution upgrades a node automatically only if 
the upgrade will have no effect on any other links that are already connected 
to that node.

• If the node does not support the required port type already, a dialog box 
might prompt you to confirm the proposed upgrade. 

Easier Statistic Selection in Results Browser

You now can change the order in which results are listed in the results treeview 
of graph and parametric studies pages in the Results Browser. This lets you 
arrange the tree to group results by their parent objects, by name, by specific 
tags (which identify related statistics), or any other way that provides convenient 
access to the results in which you are interested. These arrangements can be 
saved and reused.

For more details, see Defining an Arrangement for the Results Browser on 
page 7.
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Edit Attribute Dialog Box Enhancements

The Edit Attribute dialog box enhancements are:

• Filtered Search Feature on page 18

• Display of Compound Attributes on page 18

Filtered Search Feature

The search feature on the Edit Attributes dialog box has been enhanced so that 
you can more easily locate attributes. In previous releases, the search feature 
cycled through the Edit Attributes dialog box with the next attribute or value that 
matched the search criteria. In release 2.1, the search feature filters the attribute 
display.

When performing a filtered search from the Edit Attributes (Advanced) dialog 
box, you can specify whether filter criteria is a substring, an exact match, or a 
regular expression. Additionally, you can filter more precisely by specifying the 
items to compare against the filter criteria. Choose from attribute name, value, 
possible value (a value that you can choose from a pull-down menu), or tag. (A 
tag is a keyword that is associated with a model attribute, such as an interface 
type, vendor, or CLI command.)The results of a filtered search include built-in, 
hierarchical, and matching attributes/values.

For more information, see Filtering Attributes on page 7.

Display of Compound Attributes

To make the display of compound attributes more friendly, the “row” attribute 
has been changed to “Number of Rows”. Additionally, when a compound 
attribute is collapsed, the defined values no longer appear in the values column. 
Instead, you can view the defined values in a tooltip by holding the mouse 
pointer over “…” in the Value column.

Figure 2.1-1   Compound Attribute Display in Attributes Dialog Box

For more information, see Compound Attributes on page 40
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Enhanced Usability of Compound Attribute Table Dialog Box

The Compound Attribute Table dialog box has been enhanced with the following 
new features:

• Row Number Display—In previous releases, the row number column would 
slide out of view as you moved the slider to view columns. In 2.1, when the 
new “Show row labels” checkbox is selected, the row number column is 
frozen as you move the slider bar to view additional columns.

• Column Sorting—You can sort the table by a column by clicking the column 
header. Click the column header again to reverse the sort order. Click the 
column header a third time to turn off the sort feature.

For more information, see Compound Attributes on page 40.

Subnet Enhancements

The following functionality and behavior enhancements have been made to 
subnets:

• Create Subnets—In addition to creating subnets from the Object Palette, 
you can now quickly and easily create subnets from the Topology menu.

For more information, see Creating a Subnetwork from the Topology Menu 
on page 25.

• Create and Populate Geographic Subnets—The “Create and Populate 
Geographic Subnets” feature allows you to quickly create and populate 
subnets at specific geographic locations. This feature uses the 
latitude/longitude information stored in the default maps to create a tree of 
geographic regions (i.e., continents, countries, states/provinces, and cities).

The “Create and Populate Geographic Subnets” feature is especially useful 
when you want to organize a large set of imported nodes into a geographic 
subnet hierarchy. After creating and populating the geographic subnets, you 
can save the subnet hierarchy to a model assistant file that can be re-applied 
the next time the nodes are imported.

For more information, see Creating and Populating Geographic Subnets on 
page 73.

• Cut, Copy, and Delete Links connected to Nodes in Other 
Subnets—You can now cut, copy, and delete links that are attached to 
nodes in another subnet. However, before performing a cut, copy, or delete 
operation, be sure to select only the links on which you want to perform the 
operation.
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Logical Object Selection Enhancements

The Logical Object Selection dialog box has been replaced by a new user 
interface and functionality. The new Define Selection dialog box enables you to:

• Find/select objects based on object type (such as mobile nodes or duplex 
links)

• Find/select objects that contain specific attributes (simple, top-level, or 
nested)

• Find/select objects based on specific attribute settings

— String-based criteria include "Contains sub-string", "Matches string", and 
"Matches regular expression"

— Numerical criteria include "=", "!=", "<", "<=", ">", and ">="

• Combine search criteria using AND, OR, and NOT operators

• Create composite search definitions based on previously defined definitions

• Categorize and save, and re-use search definition files for object searches 
and User-Defined Reports.

The new functionality provides much better support for nested attributes. You 
can create search definitions based on any attribute, in any network object in a 
scenario.

For more information, see Logical Object Selection on page 20.

Zooming/Panning Enhancements

Zooming and panning in the Project Editor have been greatly enhanced.

• Zooming can now be performed with the scroll wheel on your mouse:

— To zoom in, turn the scroll wheel forward or use the Page Down button.

— To zoom out, push the scroll wheel backward or use the Page Up button.

• Panning can now be performed with the scroll wheel on your mouse

— To pan, hold down the scroll wheel and drag the mouse pointer. 
Optionally, hold down the right and left mouse buttons and drag the 
mouse pointer.

Note that in previous releases, using the scroll wheel on your mouse moved the 
view up/down. In 2.1, to move the view up/down, hold down the Control key and 
turn the scroll wheel.
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Map Improvements

The background maps have been replaced with maps that are easier to view, 
display more information, and include additional behavior.

• The default map colors have been changed to maximize visualization of 
objects and to be more aesthetically pleasing.

• Maps now display cities by population.

The following preferences define the appearance of the new maps:

— network_world_map.default_cities_style—Specifies the cities (by 
population size) to display on background maps.

— network_world_map.default_ocean_style—Specifies whether to display 
bodies of water in blue on background maps.

— network_world_map.default_region_style—Specifies whether to display 
land (with country, state, province borders) on background maps.

• Because the new maps replace old maps, some of the old maps are 
deprecated. The maps that are deprecated are the border maps (also known 
as the CDS maps) and a subset of the MIF maps. The deprecated MIF maps 
are: asia, australia, canada, europe, france, germany, italy, japan, mexico, 
ocean_background, south_korea, usa, world, and world_bright.

The following preferences control the migration from the old deprecated 
maps to the new maps.

— network_world_map.deprecated_border_map_behavior—Specifies 
whether to suppress deprecated border maps in subnets.

— network_world_map.deprecated_mif_map_behavior—Specifies 
whether to show deprecated MIP maps in subnets.

— network_world_map.update_behavior—Specifies whether to replace 
deprecated maps with new maps. Replaced maps are retained, but they 
are not displayed.
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Embedded Bird’s-eye Viewer

The Bird’s-eye Viewer is now embedded in the Project Editor workspace. An 
embedded viewer is easier to use than the floating viewer.

To toggle the display of the embedded bird’s-eye viewer, click the Embedded 
Bird’s-eye Viewer button. The button is located in the lower-right corner of the 
Project Editor, as shown in the following figure.

Figure 2.1-2   Embedded Bird’s-eye Viewer

The embedded bird’s-eye view includes the same functionality as the bird’s-eye 
view displayed from the View menu. Use the Bird’s-eye Viewer to zoom, pan, 
and locate items of interest.

For more information, see Zoom Operations on page 64.

Toggle Display of Links

Frequently, after an import, there is a need to move nodes/subnets in the 
workspace. However, if there are numerous links, the links may interfere with 
the dragging and repositioning of the network objects.

Starting in release2.1, you can toggle the display of links in the Project Editor. 
When links are hidden, it is much easier to reposition nodes/subnets. When 
satisfied with the node layout, you can show the links.

• To hide the links, choose View > Links > Hide All

• To display the links, choose View > Links > Show All

Hiding and showing links does not change the link bundling display or settings.

When links are hidden, links are not listed in the Network Browser (unless you 
choose to display hidden objects), and links do not display in the Bird’s-eye 
view. However, links do display in the Network Showcase between featured 
network objects.

Click the Embedded Bird’s-eye Viewer 
button to toggle the display of the 
Embedded Bird’s-eye Viewer
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Resolved Problems

Release 2.1 includes enhancements that address the following software 
problem reports (SPRs) from previous releases:

Table 1   SPRs Fixed in Cisco AAS Release 2.1 

SPR ID Problem Description

103789 Cisco AAS Quickview: Program abort when trying to view decodes of very large 
packets.

102014 Upgrade Cisco AAS Capture Agents to use WinPcap 4.0.1.

107556 To start Cisco AAS on a 64-bit Linux machine, you need to start Cisco AAS with 
the “-32bit” flag.

101538 Direction of retransmitted packet is wrong.

100791 Cisco AAS project closes when an MS Word report is generated.

98767 When installing Cisco AAS agent without first removing the previous agent 
installation, the installer succeeds but the version of WinPcap is not upgraded 
from 3.0 to 3.1.

95395 Cisco AAS Capture Manager incorrectly loads an agent list where the 
“maximum number of packets to capture” is specified as -1.

94763 Unable to start Cisco AAS beta agent on HP-UX (related to libstdc++.sl.6).

93783 Continuous capture rolling buffer computations have rounding errors resulting 
in the maximum size being exceeded.

93612 Cisco AAS Batch Import may not import all traces.

92588 Cisco AAS AppDoctor does not detect the correct setting for SpeedScreen 
Latency Reduction in a CITRIX trace.

91043 Continuous capture exceeds rolling buffer size when the agent is stopped and 
restarted.

51973 The HTTP tab is empty for HTTP applications.

End of Table 1
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Known Issues

This release contains the known issues listed in Table 2. 

Table 2   Known Issues in Cisco AAS Release 2.1 

SPR ID Problem Description

103083 Cisco AAS ACE and Cisco AAS ACE QuickView: Certain .pcap files fail to 
import.

Workaround: Use a file format conversion utility to convert the files to .enc 
format. 

105903 Unable to run the product on Solaris machines that do not have libgcc. 

End of Table 2
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